
LAB Fit:  Summarized Tutorial  
(Curve Fitting) 

Note: if you do not want to see this quick tutorial at startup, in the “Help” menu, uncheck this option. 

 

General Information 

 
The LAB Fit is a software for Windows developed aiming the treatment and the analysis 

of experimental data. At LAB Fit you are able to: 
 

1) Treat similar data (grouped and ungrouped dataset, one or two samples); 
 

2) Treat non-similar data (each measurement given by a mean and its uncertainty); 
 

3) Calculate probabilities for many distributions (Gaussian, t-Student, Fisher-Snedecor, 
Chi-Square and Correlation Coefficient); 

 

4) Determine propagated error (error propagation up to eight independent variables); 
 

5) Plot 2D and 3D graphs (normal, parametric, imported dataset, contour of maps); 
 

6) Execute several calculations: system of linear equations, roots of function, nonlinear 
equation, ordinary differential equation (ODE up to fifth order), system of ordinary 
differential equations (first order ODE, up to five equations), approximate function for 
ODE solution, calculator, etc; 

 

7) Extract data (x;y) from a 2D graph (digitizing); 
 

8) Curve Fitting (nonlinear regression - least squares method, Levenberg-Marquardt 
algorithm -, almost 500 functions at the library with one or two independent variables, 
functions finder, there is an option that let you write your own fitting function with up to 
150 characters, 6 independent variables and 10 parameters).  

 

The LAB Fit has a menu for curve fitting and the main programs of this menu use nonlinear 
regression. The LAB Fit fits functions of one or several independent variables (from 1 up to 6), 
allowing uncertainties at the dependent variable (Y) and also at the independent variables (X). 
In case of uncertainties in X and in Y a pre-fit is made, not considering the uncertainties in X, 
that later on are transferred to Y by error propagation. At the LAB Fit library there are more than 
200 functions with one independent variable and almost 280 functions with two independent 
variables. The user disposes of a functions finder program. If necessary, there is an option for 
the user to be able to write the own fit function. Once determined the fit parameters, it's possible 
to extrapolate the fit function and, for the 2D and 3D cases, the graph of the obtained function is 
shown. For the 2D case, beyond the extrapolation possibility, the user can even include error 
bars and confidence bands to the graph. The LAB Fit has also a menu destined to the 
treatment of similar data, non-similar data and error propagation. Beyond that, there is a third 
menu with general tools like one that allows to plot a function informed by the user and many 
other types of calculations are also included. 

 

1 – Data Information: choose one among the options 
 

 



To create a new data file (up to 500 points) click on the “New” button. Select the 
adequate options at the “Data: general information” dialog box and, if you want to inform your 
data manually, click on “OK”. At the box of data acquisition inform all the values of X and 
click on “OK” (inform also sigmax, if there is any). At next, inform all the values of Y and click on 
“OK” (inform also sigmay, if there is any). When the browser appears, give a name (without 
blank spaces) to the file and click on “Save”.  
 

To paste data in columns (from Excel, for example, or other software), with up to 300 
points, select and copy them. Then, click on the “New” button and paste the data directly into 
the LAB Fit using the "Paste" button on the “Data: general information” dialog box (the last 
column must be the dependent variable or the uncertainty of the dependent variable). 
 

To extract data (graph digitizing) from a 2D graph within a bitmap file, with up to 1500 
points, click on the “New” button. At the “Data: general information” dialog box, click on the 
“xyExtract” button. Attention: After the reading process, if there are more than 500 points, LAB 
Fit will select approximately the 500 most representative points to perform the analysis. 
 

To import data from a non formatted file (txt, for example), with any amount of 
points, click on the “Imp” button. Specify the file type in columns at the “Import Data File in 
Columns” dialog box and click on “OK” (the last column must be the dependent variable or the 
uncertainty of the dependent variable). Select the file with the data in columns at the browser 
and click on “Open”. If the data is not formatted, they will be read and a new file will be formed 
using the LAB Fit data file pattern. Attention: After the reading process, if there are more than 
500 points, LAB Fit will select approximately the 500 most representative points to perform the 
analysis. <= Main approach for data supply. 
 

EXCEL Import: select the data from Excel, copy it, paste it on the NOTEPAD and 
save. The "txt" file can then be imported. 
 

Attention: data in columns, up to 300 points, can be copied (from Excel, for example) 
and pasted directly into the LAB Fit using the "Paste" button on the "Import Data File in 
Columns" dialog box (the last column must be the dependent variable or its uncertainty). 
 

To save the file generated through one of the options defined previously, when the 
browser appears, give a name (up to 40 characters) to the new file and click on “Save”. 
 

To open a data set click on the “Open” button. Select the data file at the browser and 
after click on “Open”. The values of X will be shown. If there are any corrections to be made, 
they must be done now. With everything ok, when “OK” is clicked, the other data (sigmax or Y 
or sigmay) will also be shown at the box of data acquisition.  

 
 

2 – Curve fit: choose one among the three options 
 

 
 

In case the user does not know which is the most appropriate function for the fit, the 

“Find” button can be clicked and the LAB Fit will select the functions from its library that 
best adapt themselves to the data. To do so, when the “Conditions” dialog box appears, the 
number of parameters of the functions that are going to be tested must be selected. When “OK” 
is clicked, the selection process is initiated and, after some time, the best results will be shown 
on screen. So, the user can perform the complete fit of the function that was chosen.  



To fit a function of the library the user must click on the “Libr” button. Right after, a 
dialog box with a list of the available functions will appear, with 1 or 2 independent variables, 
according to the case. The user must, then, select the fitting function and click on “OK”. Then, a 
dialog box will appear with the initial values of the parameters to be determined, the maximum 
number of iterations and the tolerance. After the inspection, “OK” must be clicked. A dialog box 
called “Power” will then appear. At the most simple fittings, the user should click on the “Fit” 
button (but it can be written 20 or 50, for safety). The “Results” dialog box with the fitting 
results will then appear (mean value and uncertainty of the parameters). The complete results 
(including covariance matrix) are available through the “Details” button. The evaluation of the 
fitting function for x values is performed by clicking on the “Evaluate” button and the analysis of 
the experimental points is available through the “Rejection” button. 
 

To fit any function the user must click on the “User” button that, right after, a dialog 
box will appear where the user must write, using Fortran standard for writting mathematical 
expressions, the fitting function (up to 150 characters) and the number of parameters of the 
function (up to 10 parameters, written in alphabetical order, starting by A). When “OK” is clicked, 
a dialog box with the initial values of the parameters to be determined, the maximum number of 
iterations and the tolerance will appear. If the user makes an approximate idea of the initial 
values of the parameters, they must be written. If not, after the inspection, just click on “OK”. A 
dialog box called “Power” will then appear. For the simplest fittings, the user should just click 
on the “Fit” button (but it can be written 100 or 200, for safety). The “Results” dialog box will 
then appear with the fitting results (mean value and parameters uncertainty). The complete 
results (including covariance matrix) are available through the “Details” button. The evaluation of 
the fitting function for x values is performed by clicking on the “Evaluate” button and the analysis 
of the experimental points is available through the “Rejection” button. 
 

In both cases, when “OK” is clicked at this “Results” dialog box, the function graph will 
be drawn.  

 
 

3 – Graph of the fitting function 
 

Before the graph be drawn; some information about it is required at a dialog box, that 
includes details about the extrapolation of the fit function. After that, the graph will be drawn 
and, to print it, there are two options currently available. 
 

To use the first option, the “Print Window” item must be clicked, at the “File” menu, but 

this option only works to print a sketch, because the printing is not of good quality: the printed 
picture will have the same resolution shown on screen.  
 

The second option makes possible to print a graph of better quality than the 
previous one, which can be done by clicking on the “Superzoom in” item at the “Graph” 
menu. The graph will be, then, drawn again, but with a resolution much higher than the original 
one, occupying a much bigger space than the available screen size. After that, at the “File” 
menu, the user must click on “Print graph (superzoom)”. 

 

To paste a graph into a document the user must choose, at the “Edit” menu, the 
“Select All” option and after, at the same “Edit” menu, “Copy” must be clicked. Then, it’s just a 
matter of opening the document, and pasting the image that was stored at the clipboard. 

 

For publication purposes, at the “Graph” menu, the user must choose the "Zoom in 
(+)" option. Then, the user must select and copy the graph. To finish, it must be used an image 
editing program to reduce and to edit the graph. See an example below (width: 275 pixels) with 
confidence band, prediction band and extrapolation included: 



 
 

Attention: all the image files generated are available by clicking on the "Files" 
button. After opening a file, the user can copy and paste the data directly into the cells of a 
plotting program (Excel, for example). 

 
 

4 – Graph of the user function 
 

See a 3D graph example for the function Y = cos(X1^2+X2^2) - sin(X1^2+X2^2), 
obtained by clicking on the “G 3D” button: 

 
 

      
 
 
 

LAB Fit - Help and Examples Files 
 

You can download help and examples files directly from the LAB Fit home page 
available at <www.labfit.net> or from the software itself, by clicking on the "Help" button. When 
the LAB Fit Help dialog box appears, click on the "Cancel" button that the software 
automatically detects the absence (if they are actually absent obviously) of the help and 
examples files and download them for you. Then install the files into the same location of the 
LAB Fit. 

 
 
 

LAB Fit - Certification SRD / NIST 
 

The LAB Fit performance has been verified using the Statistical Reference Datasets 
Project (SRD) of the National Institute of Standards and Technology (NIST). The SRD presents 
27 datasets with three levels of difficulty: lower (8 files), average (11 files) and higher (8 files). 
The results are available at <www.labfit.net> ("Home" button). All the 27 LAB Fit results are 
statistically identical to the certified values. 



LICENSE AND DISCLAIMER 
 

Using LAB Fit constitutes acceptance of all the terms stated hereafter. Note that care 
has been taken to prevent errors in the calculation of the curve fittings presented as results by 
this program. However, any consequences of the use of these results are strictly the 
responsibility of the user. The authors are not responsible for any consequences of the use of 
this product. The authors disclaim all warranties, expressed or implied. The authors will assume 
no liability for damages either from the direct use of this product or as a consequence of the use 
of this product.  
 

You are hereby granted a license to use LAB Fit for an evaluation period of 50 
executions, after that you must pay the registration fee (order online or email to the authors) to 
continue using LAB Fit. During the evaluation period the authors grant to you the same rights 
granted to a registered user (read EULA.txt into the installation directory); including to publish all 
the results generated by LAB Fit. 

 
 

How to Cite the LAB Fit (Presentation and Reference) 
 
... the analyses were performed using LAB Fit [1]. The LAB Fit is a software for Windows 
developed for the treatment and analysis of experimental data. At the LAB Fit there is the 
possibility to: treat similar data; treat non-similar data; determine propagated error; plot 2D and 
3D graphs; execute calculations (system of equations, roots of function, ordinary differential 
equations, etc); extract data (x;y) from a 2D graph (digitizing); curve fitting (nonlinear regression 
- least squares method, Levenberg-Marquardt algorithm -, almost 500 functions at the library, 
with one and two independent variables, functions finder, option that let you write your own 
fitting function with up to 150 characters, 6 independent variables and 10 parameters) ... 
 
[1] Silva, W.P. and Silva, C.M.D.P.S., LAB Fit Curve Fitting Software (Nonlinear Regression 
and Treatment of Data Program) V 7.2.48 (1999-2011), online, available at the world wide 
web at: <www.labfit.net>, date of access: Year-Month-Day. 

 
 

The software "LAB Fit" is sold as is. 
 
 

LAB Fit Files 
 (curve fitting, basic statistics, error propagation, 2D and 3D graph, tools) 

 

• Lab.exe 
• Finder_Func.exe 

• Fit.exe 

• Graph2D.exe 

• Graph3D.exe 
• xyExtract 

• Res.exe 
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